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Sekilas tentang Flash

Flash merupakan software yang memiliki kemampuan menggambar sekaligus menganimasikannya, serta mudah dipelajari. Flash tidak hanya digunakan dalam pembuatan animasi, tetapi pada zaman sekarang ini flash juga banyak digunakan untuk keperluan lainnya seperti dalam pembuatan game, presentasi, membangun web, animasi pembelajaran, bahkan juga dalam pembuatan film. 

Animasi yang dihasilkan flash adalah animasi berupa file movie. Movie yang dihasilkan dapat berupa grafik atau teks. Grafik yang dimaksud disini adalah grafik yang berbasis vektor, sehingga saat diakses melalui internet, animasi akan ditampilkan lebih cepat dan terlihat halus. Selain itu flash juga memiliki kemampuan untuk mengimpor file suara, video maupun file gambar dari aplikasi lain. 

Flash adalah program grafis yang diproduksi pertama kali oleh Macromedia corp, yaitu sebuah vendor software yang bergerak dibidang animasi web. Macromedia Flash pertama kali diproduksi pada tahun 1996. Macromedia flash telah diproduksi dalam beberapa versi. Versi terakhir dari Macromedia Flash adalah Macromedia flash 8. Sekarang Flash telah berpindah vendor ke Adobe. Semua tools pada dasarnya sama, hanya yang membedakan disini adalah adanya jenis Actionsript 3.0. Actionscript ini merupakan versi terbaru dari penulisan actionscript di flash. Namun anda jangan khawatir, actionscript 2.0 masih berlaku di Adobe Flash. 

Pengenalan Adobe Flash 

Pada bahasan awal ini, akan saya bahas mengenai dasar-dasar pengenalan tools dari Adobe Flash. Kalau anda dulu sempat mengenal Flash yang masih vendor Macromedia, tools- tools yang dipakai sebenarnya hampir sama seperti yang masih bervendor Macromedia. Dan kini, adobe flash juga masih menerapkan standarisasi dari macromedia. Hanya beberapa opsi saja yang berbeda. Saat ini adobe sudah memunculkan versi terbarunya. Yakni versi CS6, walau pun versinya tinggi tetapi kalau saya lihat, tools-tools dan default workspace-nya masih tetap hampir sama seperti versi sebelumnya. Hanya ada beberapa saja yang berbeda, di versi terbaru. Pada versi terbaru tersebut terdapat tools yang memungkinkan kita membuat efek ruang (3D). Disini saya memakaiAdobe Flash CS3, sebagai media interaktif pembelajaran. 
1.1 HALAMAN AWAL 

Halaman awal adalah tampilan yang pertama kali muncul ketika kita mengakses Adobe Flash CS3 Professional. Cara mengakses Adobe Flash CS3 Professional pertama kali yaitu double klik pada icon yang ada di desktop atau lihat dari daftar program. Tampilan start page pertama kali membuka Adobe Flash CS3 Professional 

1.2 LINGKUNGAN KERJA ADOBE FLASH CS3 

Secara garis besar, lingkungan kerja (Workspace) adobe flash cs3 terdiri dari beberapa komponen utama.

1. Menu Bar adalah kumpulan yang terdiri atas dasar menu-menu yang digolongkan dalam satu kategori. Misalnya menu file terdiri atas perintah New, Open, Save, Import, Export, dan lain-lain. 

2. Timeline adalah sebuah jendela panel yang digunakan untuk mengelompokkan dan mengatur isi sebuah movie, pengaturan tersebut meliputi penentuan masa tayang objek, pengaturan layer, dan lain-lain. 

3. Stage adalah area untuk berkreasi dalam membuat animasi yang digunakan untuk mengkomposisi frame-frame secara individual dalam sebuah movie. 

4. Toolbox adalah kumpulan tools yang sering digunakan untuk melakukan seleksi, menggambar, mewarnai objek, memodifikasi objek, dan mengatur gambar atau objek. 

5. Properties adalah informasi objek-objek yang ada di stage. Tampilan panel properties secara otomatis dapat berganti-ganti dalam menampilkan informasi atribut-atribut properties dari objek yang terpilih. 

6. Panels adalah sebagai pengontrol yang berfungsi untuk mengganti dan memodifikasi berbagai atribut dari objek dari animasi secara cepat dan mudah. 

1.3 TOOLBOX 

Fasilitas Toolbox seperti telah dijelaskan sekilas diawal adalah sekumpulan tool atau alat yang mempunyai fungsi-fungsi tersendiri untuk keperluan desain. Berikut penjelasan setiap tool yang terdapat pada Toolbox . 

1. Arrow Tool, Arrow Tool atau sering disebut selection tool berfungsi untuk memilih atau menyeleksi suatu objek. 

2. Subselection Tool, berfungsi menyeleksi bagian objek lebih detail dari pada selection tool. 

3. Free Transform Tool, berfungsi untuk mentransformasi objek yang terseleksi. 

4. Lasso Tool, berfungsi untuk memotong gambar secara manual. 

5. Pen Tool digunakan untuk menggambar garis dengan bantuan titik-titik bantu seperti dalam pembuatan garis, kurva atau gambar. 

6. Text Tool digunakan untuk membuat objek teks 

7. Line Tool digunakan untuk membuat atau menggambar garis. 

8. Oval Tool digunakan untuk menggambar bentuk lingkaran atau elips. 

9. Pencil Tool digunakan untuk membuat garis. 

10. Brush Tool digunakan untuk menggambar bentuk garis-garis dan bentuk-bentuk bebas. 

11. Ink Bottle tool digunakan untuk mengisi/mengganti Stroke(garis luar) suatu objek. 

12. Paintbucket Tool digunakan untuk mengisi area-area kosong atau digunakan untuk mengubah warna area sebuah objek yang telah diwarnai. 

13. Eye Dropper Tool digunakan untuk mengambil sampel warna. 

14. Eraser Tool digunakan untuk menghapus objek. 

15. Hand Tool digunakan untuk menggeser tampilan stage tanpa mengubah pembesaran. 

16. Zoom Tool digunakan untuk memperbesar atau memperkecil tampilan stage. 

17. Stroke Color digunakan untuk memilih atau memberi warna pada suatu garis.

18. Fill Color digunakan untuk memilih atau memberi warna pada suatu objek.

19. Swap Color digunakan untuk menukar warna fill dan stroke atau sebaliknya dari suatu 

1.4 LIBRARY 

Fungsi dari library adalah sebagai wadah untuk menyimpan program-program terpisah yang sudah jadi, seperti tombol, objek grafis, audio, video, dan lain-lain. 

1.5 ACTION SCRIPT 

Salah satu kelebihan FLASH dibanding dengan perangkat lunak animasi lain yaitu adanya action script. ActionScript adalah bahasa pemrograman Adobe Flash yang digunakan untuk membuat animasi atau interaksi, ActionScript mengizinkan untuk membuat intruksi berorientasi action (lakukan perintah) dan instruksi berorientasi logic (analisis masalah sebelum melakukan perintah). Kita bisa memunculkan panel actionScript dengan cara menekan tombol F9 pada keyboard. Atau melalui menubar dengan cara klik Window > Actions. 

Sama dengan bahasa pemrograman yang lain, ActionScript berisi banyak elemen yang berbeda serta strukturnya sendiri. Kita harus merangkainya dengan benar agar ActionScript dapat menjalankan dokumen sesuai dengan keinginan. Jika tidak merangkai semuanya dengan benar, maka hasil yang didapat kan akan berbeda atau file flash tidak akan bekerja sama sekali. ActionScript juga dapat diterapkan untuk action pada frame, tombol, movie clip, dan lain-lain. Action frame adalah action yang diterapkan pada frame untuk mengontrol navigasi movie, frame, atau objek lain-lain. 

Salah satu fungsi ActionScript adalah memberikan sebuah konektivitas terhadap sebuah objek, yaitu dengan menuliskan perintah-perintah didalamnya. Tiga hal yang harus diperhatikan dalam Action Script yaitu: 

1.5.1 Event 

Event merupakan peristiwa atau kejadian untuk mendapatkan aksi sebuah objek. Event pada Adobe Flash ada empat, yaitu: 

1. a)  Mouse event 

Event yang berkaitan dngan penggunaan mouse. 

2. b)  Keyboard Event 

Kejadian pada saat menekan tombol keyboard. 

3. c)  Frame Event 

Event yang diletakkan pada keyframe. 

4. d)  Movie Clip Event 

Event yang disertakan pada movie clip. 

1.5.2 Target 

Target adalah objek yang dikenai aksi atau perintah. Sebelum dikenai aksi atau perintah, sebuah objek harus dikonversi menjadi sebuah simbol dan memiliki nama instan. Penulisan nama target pada skrip harus menggunakan tanda petik ganda (” ”) 

1.5.3 Action 

Pemberian action merupakan lagkah terakhir dalam pembuatan interaksi antarobjek. 
Action dibagi menjadi dua antara lain:
a) Action Frame: adalah action yang diberikan pada keyframe. Sebuah keyframe akan ditandai dengan huruf a bila pada keyframe tersebut terdapat sebuah action. 
b) Action Objek: adalah action yang diberikan pada sebuah objek, baik berupa tombol maupun movie clip. 
MENGENAL ADOBE FLASH CS3 PROFESSIONAL 
Setelah mengikuti kegiatan belajar ini, Anda diharapkan dapat menyebutkan: 

· cara membuka program Adobe Flash CS3 Professional, dan 

· bagian-bagian jendela kerja Adobe Flash CS3 Professional. 

URAIAN MATERI 
Adobe Flash CS3 Professional, merupakan software yang dirancang untuk membuat animasi berbasis vektor dengan hasil yang mempunyai ukuran yang kecil. Awalnya software ini memang diarahkan untuk membuat animasi atau aplikasi berbasis internet (online). Tetapi pada perkembangannya banyak digunakan untuk membuat animasi atau aplikasi yang bukan berbasis internet (offline). Dengan Actionscript 3.0 yang dibawanya, Adobe Flash CS3 Professional dapat digunakan untuk mengembangkan game atau bahan ajar seperti kuis atau simulasi. Contoh dari game atau bahan ajar dapat Anda lihat di www.e-dukasi.net atau pada Pesona Edukasi. 

Dari pengalaman penulis menjadi juri di Lomba Pengembangan Bahan Ajar Interaktif untuk SMA yang diadakan oleh Depdiknas, banyak karya bagus yang dibuat oleh peserta (guru) dengan menggunakan software Adobe Flash CS3 Professional.
Penggunaan Adobe Flash CS3 Professional untuk animasi atau pembuatan bahan ajar interaktif tidaklah sulit, tool-tool yang tersedia cukup mudah digunakan, beberapa template dan component juga sudah disediakan dan siap digunakan. 

Dengan anggapan software Adobe Flash CS3 Professional telah terinstal pada komputer yang Anda gunakan, berikut ini langkah awal untuk mengenal penggunaan Adobe Flash CS3 Professional. 

A. Cara Membuka 
Untuk membuka program Adobe Flash CS3 Professional, Anda dapat melakukan salah satu cara berikut: 

• Klik icon Adobe Flash CS3 Professional pada dekstop (Layar monitor). 

• Klik Start Menu All Programs Adobe Master Collection CS3 Adobe Flash CS3 Professional. 

Pilih Create New Flash File (ActionScript 2.0) untuk memulai membuat file baru. Pilih Open a Recent New Open untuk membuka file flash. 
B. Mengenal Jendela Kerja 1. Mengenal Menu Dasar 
Berikut merupakan tampilan standar jendela kerja Adobe Flash CS3 Professional, saat Anda memulai membuat file baru. 

Jendela kerja aplikasi Adobe Flash CS3 

Jendela kerja Flash 8 terdiri atas : 
• Menubar
Berisi kumpulan menu atau perintah-perintah yang digunakan dalam Adobe Flash CS3. 

Menubar pada aplikasi Adobe Flash CS3 

• Toolbar
Toolbar merupakan panel berisi berbagai macam tool. Tool-tool tersebut dikelompokkan menjadi empat kelompok: Tools; berisi tombol-tombol untuk membuat dan mengedit gambar, View; untuk mengatur tampilan lembar kerja, Colors; menentukan warna yang dipakai saat mengedit, Option; alat bantu lain untuk mengedit gambar. 

	Tool 
	Nama 
	Fungsi 
	Shortcut 

	
	Selection Tool 
	Memilih dan memindahkan objek 
	V 

	
	Subselection Tool 
	Mengubah bentuk objek dengan edit points 
	A 

	
	Free Transform Tool 
	Mengubah ukuran atau memutar bentuk objek sesuai keinginan 
	Q 

	
	Gradient Transform Tool 
	Mengubah warna gradasi 
	F 

	
	Lasso Tool 
	Menyeleksi bagian objek yang akan diedit 
	L 

	
	Pen Tool 
	Membuat bentuk objek secara bebas berupa dengan titik-titik sebagai penghubung 
	P 

	
	Text Tool 
	Membuat teks (kata atau kalimat) 
	T 

	
	Line Tool 
	Membuat Garis 
	N 

	
	Rectangle Tool 
	Membuat objek berbentuk segi empat atau segi banyak 
	R 

	
	Oval Tool 
	Membuat objek elips atau lingkaran 
	O 

	
	Pencil Tool 
	Menggambar objek secara bebas 
	Y 

	
	Brush Tool 
	Menggambar objek secara bebas dengan ukuran ketebalan dan bentuk yang sudah disediakan 
	B 

	
	Ink Bottle Tool 
	Memberi warna garis tepi (outline) 
	S 

	
	Paint Bucket Tool 
	Memberi warna pada objek secara bebas 
	K 

	
	Eyedropper Tool 
	Mengambil contoh warna 
	I 

	
	Eraser Tool 
	Menghapus objek 
	E 


	Tool 
	Nama 
	Fungsi 
	Shortcut 

	
	Hand Tool 
	Menggeser Stage 
	H 

	
	Zoom Tool 
	Memperbesar atau memperkecil tampilan objek atau stage 
	M atau Z 

	
	Stroke Color 
	Memberi atau memilih warna untuk garis tepi 
	

	
	Fill Color 
	Memberi warna pada objek 
	

	
	Option Tool 
	Mengatur fungsi tambahan pada tool yang sedang aktif 
	


• Timeline
Timeline atau garis waktu merupakan komponen yang digunakan untuk mengatur atau mengontrol jalannya animasi. Timeline terdiri dari beberapa layer. Layer digunakan untuk menempatkan satu atau beberapa objek dalam stage agar dapat diolah dengan objek lain. Setiap layer terdiri dari frame-frame yang digunakan untuk mengatur kecepatan animasi. Semakin panjang frame dalam layer, maka semakin lama animasi akan berjalan. 

• Stage
Stage disebut juga layar atau panggung. Stage digunakan untuk memainkan objek-objek yang akan diberi animasi. Dalam stage kita dapat membuat gambar, teks, memberi warna dan lain-lain. 

• Panel
Beberapa panel penting dalam Adobe Flash CS3 Professional, diantaranya panel: Properties, Filters & Parameters, Actions, Library, Color dan Align & Info & Transform 

• Properties
Panel Properties akan berubah tampilan dan
fungsinya mengikuti bagian mana yang sedang diaktifkan. Misalnya Anda sedang mengaktifkan Line tool, maka yang muncul pada jendela properties adalah fungsi-fungsi untuk mengatur line/garis seperti besarnya garis, bentuk garis, dan warna garis. 

• Library
Panel Library mempunyai fungsi sebagai perpustakaan simbol/media yang digunakan dalam animasi yang sedang dibuat. Simbol merupakan kumpulan gambar baik movie, tombol (button), sound, dan gambar statis (graphic). 

2. Document Properties 
Fungsi Document Properties adalah untuk melakukan pengaturan ukuran layar, warna background, framerate, dan dimensi dari animasi yang akan dibuat. Untuk memanggil kotak dialog Document Properties, pilih jendela Properties di bawah layar, kemudian pilih tombol Size. 

MENGENAL ADOBE FLASH CS3 PROFESSIONAL 
Setelah mengikuti kegiatan belajar ini, Anda diharapkan dapat menyebutkan: 

· cara membuka program Adobe Flash CS3 Professional, dan 

· bagian-bagian jendela kerja Adobe Flash CS3 Professional. 

URAIAN MATERI 
Adobe Flash CS3 Professional, merupakan software yang dirancang untuk membuat animasi berbasis vektor dengan hasil yang mempunyai ukuran yang kecil. Awalnya software ini memang diarahkan untuk membuat animasi atau aplikasi berbasis internet (online). Tetapi pada perkembangannya banyak digunakan untuk membuat animasi atau aplikasi yang bukan berbasis internet (offline). Dengan Actionscript 3.0 yang dibawanya, Adobe Flash CS3 Professional dapat digunakan untuk mengembangkan game atau bahan ajar seperti kuis atau simulasi. Contoh dari game atau bahan ajar dapat Anda lihat di www.e-dukasi.net atau pada Pesona Edukasi. 

Dari pengalaman penulis menjadi juri di Lomba Pengembangan Bahan Ajar Interaktif untuk SMA yang diadakan oleh Depdiknas, banyak karya bagus yang dibuat oleh peserta (guru) dengan menggunakan software Adobe Flash CS3 Professional.
Penggunaan Adobe Flash CS3 Professional untuk animasi atau pembuatan bahan ajar interaktif tidaklah sulit, tool-tool yang tersedia cukup mudah digunakan, beberapa template dan component juga sudah disediakan dan siap digunakan. 

Dengan anggapan software Adobe Flash CS3 Professional telah terinstal pada komputer yang Anda gunakan, berikut ini langkah awal untuk mengenal penggunaan Adobe Flash CS3 Professional. 
A. Cara Membuka 
Untuk membuka program Adobe Flash CS3 Professional, Anda dapat melakukan salah satu cara berikut: 

• Klik icon Adobe Flash CS3 Professional pada dekstop (Layar monitor). 

• Klik Start Menu All Programs Adobe Master Collection CS3 Adobe Flash CS3 Professional. 
Beberapa saat akan muncul jendela dialog seperti berikut. 

Pilih Create New Flash File (ActionScript 2.0) untuk memulai membuat file baru. Pilih Open a Recent New Open untuk membuka file flash. 

B. Mengenal Jendela Kerja 1. Mengenal Menu Dasar 
Berikut merupakan tampilan standar jendela kerja Adobe Flash CS3 Professional, saat Anda memulai membuat file baru. 
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Jendela kerja aplikasi Adobe Flash CS3 

Jendela kerja Flash 8 terdiri atas : 

• Menubar
Berisi kumpulan menu atau perintah-perintah yang digunakan dalam Adobe Flash CS3. 

Menubar pada aplikasi Adobe Flash CS3 

• Toolbar
Toolbar merupakan panel berisi berbagai macam tool. Tool-tool tersebut dikelompokkan menjadi empat kelompok: Tools; berisi tombol-tombol untuk membuat dan mengedit gambar, View; untuk mengatur tampilan lembar kerja, Colors; menentukan warna yang dipakai saat mengedit, Option; alat bantu lain untuk mengedit gambar. 

	Tool 
	Nama 
	Fungsi 
	Shortcut 

	
	Selection Tool 
	Memilih dan memindahkan objek 
	V 

	
	Subselection Tool 
	Mengubah bentuk objek dengan edit points 
	A 

	
	Free Transform Tool 
	Mengubah ukuran atau memutar bentuk objek sesuai keinginan 
	Q 

	
	Gradient Transform Tool 
	Mengubah warna gradasi 
	F 

	
	Lasso Tool 
	Menyeleksi bagian objek yang akan diedit 
	L 

	
	Pen Tool 
	Membuat bentuk objek secara bebas berupa dengan titik-titik sebagai penghubung 
	P 

	
	Text Tool 
	Membuat teks (kata atau kalimat) 
	T 

	
	Line Tool 
	Membuat Garis 
	N 

	
	Rectangle Tool 
	Membuat objek berbentuk segi empat atau segi banyak 
	R 

	
	Oval Tool 
	Membuat objek elips atau lingkaran 
	O 

	
	Pencil Tool 
	Menggambar objek secara bebas 
	Y 

	
	Brush Tool 
	Menggambar objek secara bebas dengan ukuran ketebalan dan bentuk yang sudah disediakan 
	B 

	
	Ink Bottle Tool 
	Memberi warna garis tepi (outline) 
	S 

	
	Paint Bucket Tool 
	Memberi warna pada objek secara bebas 
	K 

	
	Eyedropper Tool 
	Mengambil contoh warna 
	I 

	
	Eraser Tool 
	Menghapus objek 
	E 


	Tool 
	Nama 
	Fungsi 
	Shortcut 

	
	Hand Tool 
	Menggeser Stage 
	H 

	
	Zoom Tool 
	Memperbesar atau memperkecil tampilan objek atau stage 
	M atau Z 

	
	Stroke Color 
	Memberi atau memilih warna untuk garis tepi 
	

	
	Fill Color 
	Memberi warna pada objek 
	

	
	Option Tool 
	Mengatur fungsi tambahan pada tool yang sedang aktif 
	


• Timeline
Timeline atau garis waktu merupakan komponen yang digunakan untuk mengatur atau mengontrol jalannya animasi. Timeline terdiri dari beberapa layer. Layer digunakan untuk menempatkan satu atau beberapa objek dalam stage agar dapat diolah dengan objek lain. Setiap layer terdiri dari frame-frame yang digunakan untuk mengatur kecepatan animasi. Semakin panjang frame dalam layer, maka semakin lama animasi akan berjalan. 

• Stage
Stage disebut juga layar atau panggung. Stage digunakan untuk memainkan objek-objek yang akan diberi animasi. Dalam stage kita dapat membuat gambar, teks, memberi warna dan lain-lain. 

• Panel
Beberapa panel penting dalam Adobe Flash CS3 Professional, diantaranya panel: Properties, Filters & Parameters, Actions, Library, Color dan Align & Info & Transform 

• Properties
Panel Properties akan berubah tampilan dan
fungsinya mengikuti bagian mana yang sedang diaktifkan. Misalnya Anda sedang mengaktifkan Line tool, maka yang muncul pada jendela properties adalah fungsi-fungsi untuk mengatur line/garis seperti besarnya garis, bentuk garis, dan warna garis. 

• Library
Panel Library mempunyai fungsi sebagai perpustakaan simbol/media yang digunakan dalam animasi yang sedang dibuat. Simbol merupakan kumpulan gambar baik movie, tombol (button), sound, dan gambar statis (graphic). 

2. Document Properties 
Fungsi Document Properties adalah untuk melakukan pengaturan ukuran layar, warna background, framerate, dan dimensi dari animasi yang akan dibuat. Untuk memanggil kotak dialog Document Properties, pilih jendela Properties di bawah layar, kemudian pilih tombol Size. 

MEMBUAT ANIMASI OBJEK BERGERAK 
Setelah mengikuti kegiatan belajar ini, Anda diharapkan dapat membuat: 

· Animasi objek bergerak dengan pergeseran tempat 

· Animasi objek bergerak membesar atau mengecil 

· Animasi objek bergerak dengan berputar 

· Animasi perubahan bentuk. 

Animasi Gerak dengan Pergeseran Tempat
Untuk membuat animasi sebuah objek yang dapat bergerak/ bergeser dari suatu tempat ke tempat lain (ke samping, ke atas, ke bawah dan sebagainya) langkah-langkahnya sebagai berikut: 

1. Setelah membuat file baru, pilih Oval tool ( ) pada toolbar (atau tool yang lain sesuai bentuk 

objek yang akan dibuat). 

2. Buat sebuah lingkaran pada layar kerja. 

3. Pilih Selection tool ( ), kemudian klik dua kali pada lingkaran untuk mengaktifkan lingkaran. 

4. Pilih Modify > Convert to symbol 
5. Pada kotak dialog yang tampil isikan seperti berikut: 

6. Pilih OK 
7. Klik mouse di frame 30 pada Timeline, kemudian pilih Insert > Timeline > Keyframe atau Klik kanan mouse pilih Insert Keyframe. 
8. Klik mouse pada lingkaran, kemudian geser lingkaran ke sembarang tempat (sebagai contoh di sini digeser ke arah kanan) 
9. Blok pada Timeline dari frame 1 hingga frame 30. 
10. Pilih jendela Properties, pada pilihan Tween pilih Motion. 

Atau
Klik kanan mouse pada Timeline pilih Create Motion tween 
Sekarang coba jalankan animasinya dengan cara pilih Control Play atau tekan Enter pada keyboard
Catatan :
Anda dapat merubah gerakan awal dan akhir dengan cara: 

Klik mouse pada frame 1 (untuk awal gerakan) kemudian ubah letak lingkaran pada layar, dan klik mouse pada frame 30 (untuk akhir gerakan) kemudian ubah letak lingkaran.
Untuk mempercepat gerakan animasi geser keyframe akhir ke kiri (<30) dan untuk memperlambat geser ke kanan (>30). 
Animasi Gerak dengan Pembesaran atau Pengecilan Bentuk
Untuk membuat animasi gerak dengan pembesaran atau pengecilan bentuk, lakukan langkah yang sama dengan pembuatan animasi pergeseran tempat hingga langkah ke 10. 

1. Kemudian klik frame 30 pada Timeline. 

2. Pilih Free Transform Tool ( ) , arahkan kursor ke salah satu titik sudut yang muncul di 

gambar lingkaran. Sambil menekan tombol Shift pada keyboard, Klik mouse pada titik tersebut dan geser ke arah luar hingga lingkaran membesar. Kemudian lepaskan mouse. 

Jalankan animasi dengan menekan tombol Enter. 

Catatan:
Untuk membuat objek mengecil, saat menggeser sebuah titik pada lingkaran arahkan ke dalam hingga lingkaran mengecil. 

Animasi Gerak dengan berputar
Untuk membuat animasi gerak dengan berputar, lakukan langkah yang sama dengan pembuatan animasi pergeseran tempat hingga langkah ke 10. 

1. Pilih Selection tool ( ), kemudian klik dua kali pada lingkaran atau klik kanan mouse pada lingkaran, pilih Edit in Place. 

2. Pilih Paint Bucket Tool ( ) 

3. PilihWindowColorMixer 
4. Pada jendela Color Mixer pilih Radial pada pilihan Type 
5. Kemudian arahkan kursor ke lingkaran (jangan ditengah-tengah) dan klik mouse. Catatan: 

Langkah di atas bertujuan agar saat lingkaran diputar terlihat gerakkannya. 

6. Tutup jendela lingkaran dan kembali ke jendela Scene 1 dengan cara klik pada tab Scene 1. 

7. Kemudian klik frame 30 pada Timeline. 

8. PilihModifyTransformRotateandScale 
9. Pada jendela Scale and Rotate isi kolom Rotate dengan 180 (angka ini menunjukkan berapa 

derajat objek akan berputar) 

10.Pilih OK 

Jalankan animasi
Catatan:
Untuk membuat animasi yang dapat bergerak berputar sambil membesar atau mengecil, Anda dapat mengisikan nilai Scale dan Rotate secara bersamaan pada jendela Scale and Rotate. 

Animasi Perubahan Bentuk
1. Buat sebuah file baru.

2. Dengan menggunakan Oval Tool ( ) buatlah sebuah bentuk oval. 

3. Klik di frame 40 pada timeline, klik kanan mouse pilih Insert Blank Keyframe. 
4. Di posisi frame ke-40, buatlah sebuah persegi. 
5. Klik mouse pada bagian tengah timeline, pilih jendela Properties, pada opsi Tween pilih Shape. 
5. Jalankan animasi. 

Untuk memperoleh animasi yang gerakannya lebih teratur, dapat digunakan Shape Hints. Sebagai contoh dapat dipraktekkan pada animasi yang baru saja kita buat.
1. Klik mouse pada frame pertama. 

2. Pilih Modify Shape Add Shape Hint, akan muncul bulatan kecil berwarna merah. 

3. Ulangi sebanyak tiga kali kemudian drag masing-masing titik a, b, c, d sesuai gambar. 

4. Klik mouse pada frame terakhir. 

5. Pindahkan masing-masing titik a, b, c dan d, sesuai gambar. Titik akan berubah menjadi hijau. 

6. Klik kembali mouse pada frame pertama. Dapat dilihat bahwa titik berubah menjadi kuning, artinya, Shape Hint telah berhasil. 

7. Jalankan animasi. 

BERUBAH-UBAH WARNANYA
Setelah mengikuti kegiatan belajar ini, Anda diharapkan dapat: 

· Menggunakan teks pada flash 

· Mengkonvert teks menjadi vektor 

· Membuat animasi teks berubah-ubah warnanya 

URAIAN MATERI
A. Menggunakan Teks 
Untuk menambahkan teks ke dalam stage pilih Text Tool ( ) pada toolbar kemudian klik pada stage. Sebuah kotak kosong akan muncul. Untuk mengubah jenis, ukuran serta warna font, gunakan jendela Properties di bagian bawah layar. 

B. Animasi Teks berubah-ubah Warna 
Untuk sebuah judul program terkadang perlu dibuat menarik dengan cara membuat teks pada judul tersebut bergerak atau berubah-ubah warnanya.
Dengan Adobe Flash CS3 Professional, membuat animasi tersebut bukanlah hal yang sulit. 

1. Pertama buat file baru, melalui jendela Properties ubah warna background menjadi hitam. 

2. Pilih Text Tool ( ) 

3. Pada jendela Properties, atur : Static Text, Arial, 40 warna Kuning, Anti-alias for animation 

(lihat gambar). 

4. Klik mouse pada stage, ketikkan JUDUL (judul program). 

5. Atur posisi agar di tengah layar kerja. 

6. Pilih Modify Break Apart atau tekan CTRL + B 
7. PilihModifyConverttoSymbol 
8. Pada jendela Convert to Symbol, beri nama judul, pilih Graphic, pilih OK 
9. Klik di frame 15 pada Timeline, Klik kanan mouse Insert Keyframe. 
10. Klik di frame 30 pada Timeline, Klik kanan mouse Insert Keyframe. 
11. Klik di frame 15 pada Timeline
12. Klik mouse pada teks JUDUL 
13. Pada jendela Properties, pilih Color Tint, atur warna ke Jingga (atau yang lain), kepekatan 100%. 
14. Blok frame 1 hingga 30, Klik kanan mouse pada timeline Pilih Create Motion Tween. 15.Jalankan animasi. 
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